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Windows Tutorial

If you’re not familiar with Windows, review this Windows Tutorial carefully.
You’ll learn how to
● Use a mouse
● Start Windows
● Use the taskbar, menus, dialog boxes, and other important aspects

of Windows

If you’re familiar with Windows but need help navigating Windows files and
folders, refer to “File Management.” There you’ll find information on how Win-
dows stores information and how to use Windows Explorer, a tool for managing
files and folders.

NOTE: All examples in this Tutorial refer specifically to Windows XP. If you
are using any other version of Windows, your screen might differ slightly from

the images shown in this Tutorial. However, because most basic features are common to
all versions of Windows, this Tutorial should be helpful to you no matter what version of
Windows you use.

Computers differ in the ways they can be set up. In most cases, when you turn
on your computer Windows loads automatically and the Windows logon screen
appears. However, before Windows XP lets you in, you need to log on and give the
computer your password. In order to log on, you need to know how to use the
mouse, a device attached to your computer.

Using the Mouse
A mouse is a pointing device that is typically attached to your computer. Optical
versions, which are not attached, are also available. The mouse is your access to
the computer screen, allowing you to accomplish specific tasks. It operates
through a cursor, a screen object you use to point to things on the computer screen.
The normal shape for the mouse cursor is a pointer arrow. To move the pointer ar-
row on the screen, you roll the mouse on any flat surface, or on a mouse pad,
which has a smooth surface designed for easy mouse rolling. Although you can
use the keyboard with Windows, you’ll probably find yourself using the mouse
most of the time.

To use the mouse to position the pointer to an object on the computer screen:

1. Turn on the computer (if it isn’t on already). Windows loads and the logon
screen appears. The screen includes a logon name and picture assigned to
you by your instructor.

To log on, you need to move the screen pointer to the logon name that was
assigned. The pointer on the computer screen mirrors the actions made by
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the mouse when you roll it. Place your hand over the mouse and roll it to
the left. The pointer on the screen moves to the left.

2. Roll the mouse to the right, and watch the pointer on the screen move to
the right.

3. Practice rolling the mouse in all directions. When moving the mouse on the
mouse pad, if you reach the edge of the pad, just pick up the mouse and
place it in the center of the pad. Try it now to see how it works.

4. Roll your mouse to the edge of the pad, and then lift it and place it back
in the middle of the pad. When you feel that you can control the mouse
position on the screen, roll the mouse to the name you have been assigned.

To log on, you will need to click the name to select it. Mouse clicks are covered
in the next section; instructions for logging on to Windows XP are covered in suc-
ceeding sections.

Clicks and Double-Clicks
A mouse typically has two buttons at the front (the edge of the mouse where the
cord attaches)—one on the left and one on the right. (A mouse might also have a
center button or a wheel. Since these are not typical, a center button or wheel isn’t
discussed in this Tutorial.)

Single-click actions with the mouse are used to locate the pointer at a specific
screen location. To perform a single click:

1. Roll the mouse around on the mouse pad until the pointer on the screen is
over an item the screen. Remember that the direction in which you move
the mouse on the pad represents the pointer’s movement on the screen.

2. Press and release the left mouse button once. Pressing and releasing the
mouse button is referred to as a click. The computer tells you that the action
has been performed when the object you click is highlighted (typically, the
color of the selected object changes) to indicate to you that it has been
selected. In Windows, you often need to select an object before you can
perform some action on it. For example, you usually need to select an object
before you can copy it. (Working with text is somewhat different and will be
covered in succeeding paragraphs.)

Pressing and releasing the mouse button twice is referred to as a double-click.
When you double-click an object on the screen, it is selected—the object high-
lights—and an action is performed. For example:

● When you double-click a folder, it highlights and opens to a window
showing the items it contains.

● When you double-click a word in a text file, it is selected for a future
action. In a text file, the pointer becomes an I-beam for selecting a location
in the text.

NOTE: Whenever you’re told to “click” or “double-click” an item on the
computer screen, use the left mouse button.
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Selecting and Dragging
You can also select a larger object such as a picture or a block of text by using
the mouse.

1. Position the pointer on one side of the object and hold down the left mouse
button.

2. Roll the mouse until the pointer reaches the other side of the object.

3. Release the mouse button. The selected object is highlighted.

”Drag and Drop”—Moving
an Object Using the Mouse

You can use the mouse to move an object on the screen to another screen location.
In this operation, you select an object and drag the mouse to move the selected ob-
ject, such as an icon. The operation is known as drag-and-drop.

1. Using the mouse, move the pointer over the object you want to drag.

2. Perform a single-click action by pressing the left mouse button but keep it
pressed down. The selected object will highlight.

3. With the left mouse button still depressed, roll the mouse until the pointer
and selected object are placed at the desired new location.

4. Release the mouse button position in order to drop the object. The object is
now positioned at the new location.

Using the Right Mouse Button
Pressing and quickly releasing the right mouse button is referred to as a right-click.
Although the right mouse button is used less frequently, using it can be a real
time-saver. When you right-click an icon, a shortcut menu appears with commands
including Edit, Save, Rename, etc., just like the standard menu bar items. Right-
clicking and menus are covered later in this Tutorial.

As you progress in this Tutorial, you will become familiar with the terms in
Table 1, describing the actions you can take with a mouse.
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TERM DESCRIPTION

Point Roll the mouse until the tip of the pointer is touching the desired item on the computer
screen.

Click Quickly press and release the left mouse button. Single-clicking selects screen icons.

Double-click Quickly press and release the left mouse button twice. Double-clicking selects an object
and performs an action such as opening a folder.

TABLE 1 Mouse Terms

continues
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Pointer Shapes
As you perform actions onscreen using the mouse, the onscreen arrow-shaped
pointer changes its shape, depending on where it is located and what operation
you are performing. The term cursor is the generic term for all the shapes that a
pointer may take. Table 2 shows the most common types of pointers.

Starting Windows: The Logon Screen
The Windows XP logon screen allows several people to use the same computer at
different times. Each person’s files are hidden from the others using the computer.
However, users may share selected files using the Shared Document folder. The
logon screen lists each user allocated to the computer by name.

If the administrator has added your name to a given computer, the logon
screen will include your name. If the computers are not assigned to specific indi-
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TERM DESCRIPTION

Drag Point to an object onscreen, hold down the left mouse button, and roll the mouse until
the pointer is in position. Then release the mouse button (drag-and-drop).

Right-click Quickly press and release the right mouse button. A selection menu for object appears.

Select When working in Windows, you must first select an object in order to work with it.
Many objects are selected with a single click. However, depending on the size and
type of object to be selected, you may need to roll the mouse to include an entire area:
Holding down the left mouse button, roll the mouse so that the pointer moves from one
side of an object to another. Then release the mouse button.

TABLE 1 Mouse Terms continued

CURSOR NAME DESCRIPTION

Pointer Used to point to objects.

I-Beam Used in typing, inserting, and selecting text. When the I-beam is moved to a
selected location, it turns into a blinking bar that remains on the screen.

Two-Headed
Arrow

Used to change the size of objects or windows.

Four-Headed
Arrow

Used to move objects.

Hourglass Indicates the computer is processing a command. While the hourglass is
displayed, it is best to wait rather than try to continue working. NOTE: Some
hourglass actions will actually not allow you to perform other procedures until
processing is completed.

Hand Used in Window’s Help system to display additional information. It is
occasionally used by some graphics programs for drag-and-drop actions.

TABLE 2 Frequently Used Mouse Cursors
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viduals, you may find a box for Guest or for a generic person. If your computer is
on a network, your instructor might need to provide you with special start-up
instructions.

After you have logged on to Windows XP, the desktop is the first thing that ap-
pears on the computer screen. It is your onscreen work area. All the elements you
need to start working with Windows appear on the desktop.

NOTE: On some computers, the logon screen does not appear
automatically. You might have to press the following keys, all at once, and

then quickly release them: [Ctrl]+[A]+[Y].

1. If you have not already turned on the computer, do so now to begin the
Windows XP loading process. The Windows logon screen appears.

2. Click your name to select it. The Password box appears with an I-beam
cursor in position ready for you to type your password.

3. Type in your password.

4. Click the arrow icon to the right of the box. If you have entered the
password correctly, the Windows desktop appears. If you made an error,
the Password box returns for you to type in the correct password.

NOTE: If you don’t remember your Windows password, click the ? icon on
the right of the box for the clue you gave when you selected your password.

Otherwise, ask your instructor for help.

The Windows Desktop
If you have worked on an earlier version of Windows, you will find that the Win-
dows XP desktop screen is less cluttered and more colorful. The icons that ap-
peared in Windows NT and other earlier versions of Windows are no longer part
of the standard desktop. Instead, you’ll find an empty screen, with a newly de-
signed taskbar at the bottom. At the left of the taskbar is a large green Start button,
your entry point into many XP functions. Along the taskbar are a variety of small
buttons for program access and other functions. The new design allows you to
perform many Windows tasks easily, once you become familiar with all the
taskbar functions.

NOTE: If you yearn for the old traditional screen, you can select the
Classic view, which is described under “Changing the Display to Classic View”

later in this Tutorial. See Figure 1 on the next page.

TIP: This is a good place to practice using the mouse, following the
procedures described at the beginning of the Tutorial.

Using the Start Menu
Clicking the taskbar Start button opens a large two-panel menu with lists of
commands and shortcuts to programs and Windows tasks. If this is a computer
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assigned to you for logon, your Start screen will contain items that may differ
from those of another user assigned to the same computer. To open and learn
about the Start menu, first click the Start button on the Windows taskbar. The Start
menu appears. Across the top is a bar containing your logon name.

The left panel consists of three sec-
tions divided by separator lines. The
top section, called the pin area, lists pro-
grams that are always available for you
to click. These can include your Internet
browser, mail, your word processor, etc.
You can remove programs you don’t
want listed, rearrange them, and add
those you prefer.

Below the separator line are short-
cuts to programs you use most often,
placed there automatically by Win-
dows. You can remove programs you
don’t want listed, rearrange them, but
not add any manually.

6 OFFICE

FIGURE 1
Windows XP

desktop

TaskbarStart button

FIGURE 2
Start menu
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The right panel, also divided into three sections, includes icons for My Doc-
uments, My Computer, Control Panel, Search, Run, and others. Depending on
how your computer is set up, your icons might be different from those shown
in Figure 2.

Table 3 describes the typical components of the Start menu.

OFFICE 7

COMMAND USE

Top Bar Lists the name of the user currently logged on to the computer. The Start window
for each logged-on user can vary.

Left Panel Pins You can add or delete these items and arrange them in the order you like.

Internet Connects to the browser chosen as the default.

E-mail Connects to the chosen e-mail service.

Microsoft Word Connects to the word processing program you use.

Below the first separator line

Left Panel Programs Windows lists programs you use most often here. You can delete items or
rearrange them, but you can’t add any manually.

Below the second separator line

All Programs Clicking All Programs or the large sideways triangle to its right displays a menu
with submenus listing the programs on your computer. Programs with a
sideways triangle on the right indicate items in a submenu. Drag to and click a
program to instruct Windows to open it.

Right Panel Gives you direct access to standard Windows programs and component
elements.

Right Panel Top

My Documents When you double-click this icon, a new window opens showing all the files in
your My Documents folder.

My Recent Documents Shows up to 15 of the most recent documents you worked on and saved.

My Pictures Displays the picture files contained in your My Pictures folder.

My Music Displays the audio files contained in your My Music folder.

My Computer Shows icons representing the disk drives available on your computer (and on
your network, if you are on one). Use My Computer when you want to view the
contents of a hard disk or a floppy disk.

My Network Places Displays the icons showing your network connections.

Below the first separator line

Control Panel Displays the Control Panel listing Windows components for which you can
change settings. The computer administrator may limit your access to some of
these components.

Connect To Displays a selection menu for Internet and LAN connection sites. The
administrator may block this feature.

Printers and Faxes Displays a selection menu for the printers and faxes attached to your computer.

TABLE 3 Components of the Start Menu

continues
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Using the All Programs Command
Most programs on your computer can be started from the All Programs command
on the Start menu. This is the easiest way to open a program not listed directly in
the Start menu.

1. To open the All Programs menu, click the Start button. The Start menu appears.

2. Click All Programs or the large triangle to its right at the bottom of the left
panel. The All Programs menu/submenu appears, listing the programs
installed on your computer. Every computer has a different list of programs.
Notice that some menu entries have an arrow to their right. When you click
an arrowed entry, its submenu appears. Some submenus contain a third
menu level. This menu system is also called cascading menus.

3. Drag to the program you want to open and click. For the purposes of this
Tutorial, open Word, a word processing program in Microsoft Office. See
Figure 3 on the next page. In a few seconds, the program you selected loads
and its first screen appears. Notice that a button for the program appears on
the taskbar. Leave Word open for the present.

Customizing the Start Menu
Both the Start menu and the desktop can be customized. You can add shortcuts to
the desktop if you prefer. You can add and delete items from the Start menu. How-
ever, if your computer is used by others, the Administrator may limit some cus-
tomization functions.

8 OFFICE

COMMAND USE

Below the second separator line

Help and Support Starts the Windows Help function. Windows Help offers instructions on how to
perform tasks in the Windows environment.

Search Displays a window listing commands that enable you to locate a file, folder,
Internet address, or person.

Run Opens a dialog box that allows you to type a command to start a program. It is
best to avoid this function until you are a more experienced user.

Bottom Bar

Log Off A dialog box with settings that can disconnect your access to the computer and/
or prepare your computer for someone else to use.

Turn Off Computer A dialog box with settings that Stands By, Turns Off, or Restarts your computer,
or else places it in a Hibernate mode. Stand By puts your computer to sleep.
You wake it up by using your mouse or the keyboard. Hibernate, accessed by
pressing the [Shift] key, memorizes the programs, documents, and computer state
you have running when you turned off the computer. When you log on again,
these are activated.

TABLE 3 Components of the Start Menu continued
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To add a program to the pin area at the top left of the Start menu:

1. Select the program you want to add to the pin list from the All Programs
menu in Start and right-click it. Its menu appears.

2. Click Pin To Start on the menu. The program will be added to the pin list in
the left panel above the separator line.

To remove a program from the pin area at the top left of the Start menu:

1. From the pin menu in Start, select the program you want to remove from
the pin list and right-click it. Its menu appears.

2. Click Unpin From Start on the menu. The program will be removed from the
pin list.

To change the order in which programs are listed in the pin area:

1. Click to select the item and press the left mouse button.

2. Drag to the desired position.

Using the Taskbar
The newly designed taskbar at the bottom of your screen is one of the most impor-
tant features in Windows XP. The taskbar is divided into several segments, each
dedicated to a different use. Using the taskbar, you can switch between open pro-
grams and between open documents within a program.
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FIGURE 3
All Programs

window
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Windows displays a button on the taskbar for each opened program and docu-
ment. Notice that there is a button for Word, showing that it is still open. Since the
taskbar can become crowded, Windows combines access to documents or pro-
grams under single buttons. An arrow to the right of a button indicates what is
available under that button. The shape of the arrow varies, depending on what the
button contains. Clicking the arrow opens the menu of available items.

Taskbar Notification Area
The notification area is on the right side of the taskbar, where the current time is
usually displayed. Along with displaying the time, tiny icons notify you as to the
status of your browser connection, virus protection, etc. In the interests of remov-
ing clutter, the notification area hides most of the icons. Clicking the round button
with a sideways arrow to the left of the notification area “hides” or “unhides” the
items in it.

TIP: If you are not sure of what an item is or does, pointing to it without
clicking displays a balloon with a short description.
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FIGURE 4
The desktop with the

taskbar and the
Word window

Menu bar

New Blank
Document button

Active Window

Notification area

Sizing buttons

FIGURE 5
Button contents for
Word documents

Open documents in Word

Taskbar button for open Word program
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The Active Window
The window in which you are working is called the active window. The title bar for
the active window is highlighted, and its taskbar button is also highlighted. The
program window for Word that you opened earlier should still be open. To exam-
ine additional features of the taskbar, open a second program, Excel, a spread-
sheet program in Microsoft Office.

1. If Word is not open, click the Start button and then click All Programs, Word
from the Start menu. The Word window displays.

2. Click the Start button and then click All Programs, Excel from the Start menu.
The Excel window displays. Notice how the Excel window covers the Word
window, indicating that the window containing Excel is now active. Notice,
too, that a new button has been added to the taskbar for Excel.

3. Click the button on the taskbar for Word, the first program you opened.
Word reappears in front of Excel.

4. Click the button on the taskbar for Excel. Notice that you switch back to it.

5. Click the button on the taskbar to return to Word.
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FIGURE 6
Excel is the active
window, covering

the Word window.

Taskbar button for open Excel program

The Excel window is now
the active window.
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To start a new blank document in Word:

1. Click the New Blank Document button on the Word toolbar located near the
top of the screen (see Figure 4). Because the toolbar is now crowded, notice
that the button for Word now has a “2” on it, and an upside-down triangle
arrow at the right. This indicates that the button contains two documents.

2. Click the arrow. The button contents files are displayed as shown in Figure 5.

3. Drag and click the first Word program you opened.

4. Practice using the taskbar to switch between Excel and Word windows and
between Word document windows until you feel comfortable with this
process.

Changing the Size of the Taskbar
You can change the size of the taskbar using your mouse if your toolbar is very
crowded. It is usually not necessary, because of the multiple document style but-
tons and other hide/unhide arrows on the taskbar.

1. Move the pointer to the top edge of the taskbar until it changes from a
pointer to a two-headed arrow. Using the two-headed arrow, you can
change the size of the taskbar.

2. With the pointer displayed as a two-headed arrow, hold down the left
mouse button and move the arrow up until the taskbar enlarges upward.

3. Move the pointer to the top edge of the taskbar once again until the two-
headed arrow displays. Hold down the left mouse button and move the
arrow down to the bottom of the screen. The taskbar is restored to its
original size.

Using Menus
Windows uses a system of menus that contain a choice of options for working
with programs and documents. Most Windows programs use a similar menu
structure. These operations are either mouse or keyboard driven. They are called
commands because they “command” the computer to perform functions needed
to complete the task you, the user, initiate at the menu level.

Executing a Command from a Menu
In Windows, each window includes a menu bar, a row of descriptive menu names
at the top, just below the title bar (see Figure 4). You open a menu by clicking the
name of the desired menu. When a menu is opened, a list of command options ap-
pears. To execute a particular command from an open menu, press the left mouse
button and then drag down and release the chosen option (click and drag).
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Keyboard Menu Commands
For people who prefer to use the keyboard to a mouse, Windows has provided
keyboard commands for many menu items. You can use the keyboard to open
menus and choose menu options.

Notice that each of the names on the menu bar has an underlined character. To
open a menu, you press the [Alt] key and the underlined letter of the menu name at
the same time. Using a combination of [Alt] and a key underlined in the command
you want to choose is called a keyboard shortcut. For example, to open the File
menu, hold down the [Alt] key and press [F]. You can use the keyboard again to
choose a menu option. For example, with the File menu open, you use [A] (the un-
derlined character from the Save As command) to choose the Save As command.
When you see underlined letters on a menu item, it means that these letters can be
used as an alternative method of executing a command. Instead of clicking the
command, you press the letter that is underlined, often in combination with an-
other letter.

Some menu items include not only the name of the command but a combina-
tion of keyboard keys. For example, under the File menu in Word, the Save com-
mand contains the notation [Ctrl]+[S] to its right. This means that you can also
execute the command by pressing the [Control]key together with the [S]key to save a
document.
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FIGURE 7
Title and menu bars

with the File menu
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a dialog box.
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Other Menu Symbols
Menus may be displayed in a short version. If you see a double-V arrow at the bot-
tom of a menu, it means that there are additional items hidden below. Click the
double V and they will appear.

Three dots following a menu option indicate that a dialog box is displayed
when that menu option is chosen. (Dialog boxes, discussed later, are small win-
dows requesting and receiving input from a user.)

Some commands also show button icons to the left as another alternative for
executing the command.

Perform the following steps for keyboard command practice:

1. Click Edit on the menu bar again. The menu closes.

2. Press [Alt]+[E], the keyboard shortcut for the Edit menu. The Edit menu
appears again.

3. Click Edit on the menu bar again to close the Edit menu.

4. Press [Alt]+[V], the keyboard shortcut for the View menu. The View menu
appears.

5. Click the down arrow at the bottom of the menu to display the entire View
menu. Some commands have check marks next to them. This means the
command can be turned on or off.

6. Notice also that all the commands in the menu have an underlined letter,
indicating that they, too, have keyboard shortcuts.

7. Click View to close the View menu.

Displaying a Shortcut Menu
When the mouse pointer is on an object or an area of the Windows desktop and
you right-click, a shortcut menu appears. A shortcut menu typically contains
commands that are useful in working with the object or area of the desktop to
which you are currently pointing.

1. Position the mouse pointer on a blank
area of the desktop and right-click.
A shortcut menu appears with commands
that relate to the desktop, including
arranging icons and displaying properties.

2. Click outside the shortcut menu to close it.

3. Right-click the time in the bottom-right
corner of the taskbar. A shortcut menu
appears.

4. Click Adjust Date/Time on the shortcut
menu. The Date/Time Properties dialog
box appears. You can use this dialog box
to adjust your computer’s date and time.
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FIGURE 8
The Time shortcut

menu
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5. Click Cancel.
6. Click outside the shortcut menu to close it.

7. Right-click an icon to display its shortcut menu, and then close the menu.

Using Dialog Boxes
Windows programs make frequent use of dialog boxes. A dialog box is a window
that requests input from you related to a command you have chosen. All Win-
dows programs use a common dialog box structure.

1. Make the Excel program the active window.

2. Choose File on the menu bar. The File menu appears.

3. Click the down arrow at the bottom of the menu to display the entire File
menu. The three dots following the Print command indicate that when you
choose Print, a dialog box will be displayed.

4. Choose Print. The Print dialog box appears. It contains some of the most
common types of dialog box options.

NOTE: A keyboard shortcut is available for the print dialog box: Press
[Alt]+[F]+[P] ([Alt]+[F] to open the File menu, [P] to open the Print dialog box).

5. To close the Print dialog box, click Cancel, located in the lower-right corner
of the dialog box. The Print dialog box closes without making any changes.
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FIGURE 9
Print dialog box

in Excel

Title bar. Drag to move box. Drop-down list box. Click arrow for more options.

Help button.
Click for Help with
dialog box options.

Close button

Text box. Key text or
click arrows.

Check box. Click to
select or deselect.

OK command button. Click
to accept specified changes
in dialog box.

Cancel command button.
Click to close without
making changes.

Option buttons.
Only one in a group
can be selected.
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Another type of dialog box is available in Word. The Word Format menu offers
many choices for choosing font styles for a document.

1. Make Word the active window.

2. Click Format on the menu bar. The Format menu appears.

3. Click Font. The Font dialog box appears.

4. This dialog box includes both tabs under the title bar and scroll boxes for
making font choices.

The scroll boxes on the top are for specifying a font by name, its style, and its
size. When you select a paragraph in a Word document, you can select its typo-
graphic features using this dialog box. The scroll box at the top left displays a list
of all the type faces installed on your computer. By clicking the name of the font,
you select it for your paragraph.

The vertical scroll bar on the right side of a box or a window indicates that
there is more content in the window. To view the entire content, click the down-
ward-pointing arrow to roll the window contents down to view through the op-
tions; click the upward-pointing vertical scroll arrow to roll the window contents
up toward the beginning of the file. You can also drag the box on the scroll bar up
or down to view all the content. The tabs at the top display other dialog boxes re-
lating to font formatting. Click each tab to view its contents, and then return to the
Font tab.

Use this dialog box to style a paragraph as follows:

1. Type a very short paragraph in your Word document.

2. Insert the I-beam cursor at the beginning of the text, holding down the left
mouse button.
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FIGURE 10
The Font dialog box

Tabs. Click to display.

Scroll box. Drag to scroll.

Scroll bar. Use to move
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Vertical scroll arrows.
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3. Drag the mouse to the end of the paragraph. It will change color, showing
that it has been selected.

4. Click Format on the menu bar and click Font. The font dialog box opens.

5. In the Font Name scroll box click Verdana. You may need to scroll down
to see it.

6. In the font Style box click Bold.

7. In the font Size box click 12.

8. If you wish to change the color of your paragraph, move your pointer to the
font color selection box on the left and click the down-facing arrow. A color
pallet appears. Drag the pointer to the color you wish to use and click.

9. When you have completed your selections, click OK at the bottom of the
font dialog box and look at the paragraph you have styled. If you wish, you
can try other font formats, while your paragraph is selected.

Changing the Size of a Window
You can change the size of any screen window using either the mouse or the sizing
buttons. Sizing buttons are the small buttons on the right side of the title bar that
allow you to resize, minimize, or maximize the window (see Figure 4). This can be
especially useful when you’d like to display several open windows on your desk-
top and see them simultaneously.

Two sizing buttons appear on the title bar of every window, to the left of the
close window button (from left to right): the Minimize button and the Restore
Down/Maximize button. Table 4 describes these buttons. To practice changing
the size of a window, follow these steps:

1. Make Excel the active window, if it is not already. Click the Maximize
button on the Excel title bar if the Excel window does not fill the entire
desktop.

NOTE: Notice that the window occupies the entire desktop, and the
Maximize button has changed to a Restore Window button. (This type of

function is known as a toggle: when a button representing one state [Maximize] is
clicked, an action is performed, the button toggles to the alternate state, and the other
button [Restore Window] appears. A number of actions in Windows operate this way.)

OFFICE 17

BUTTON USE

Minimize Reduces the window to a button on the taskbar.

Maximize Enlarges the window to fill the entire desktop (appears only when a window
is reduced).

Restore Down Returns the window to its previous size and desktop position (appears only when
a window is maximized).

TABLE 4 Sizing Buttons
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2. Click the Restore Window button on the Excel title bar. The Excel window
reduces in size, and the Word window appears behind it. The Restore
Window button has now changed to a Maximize button. Notice that the
highlighted title bar of the Excel window indicates it is the active window.

3. Click the Minimize button. The Excel window disappears, and its button
appears on the taskbar.

How to Display Two Program
Windows Simultaneously

1. From Start, click All Programs to open Excel and two Word documents if
they are not already open from an earlier section of the Tutorial.

2. Click the Excel button on the taskbar to move its window to the front of the
screen.

3. Move the pointer to the right border of the Excel window. The pointer
changes to a horizontal two-headed arrow.

TIP: Sometimes the borders of a window can move off the computer screen.
If you’re having trouble with one border of a window, try another border or

drag the entire window onto the screen by using the title bar.

4. With the two-headed arrow displayed, drag the border to the left make the
window narrower.

NOTE: You can place the pointer on any part of the window border to
change its size. To change both the height and width of the window, drag the

pointer to the bottom-right corner of the window. The double-headed arrow changes its
orientation to a 45-degree angle (See Figure 11). Dragging this arrow acts on both the
right and bottom borders.
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FIGURE 11
The two-headed

arrow for changing
a window’s size
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5. Click the title bar of one of the Word windows behind the Excel window.
The Word window becomes the active window. The Excel window is still
open, but it is now behind the Word window.

6. Click the Maximize button if the Word window does not fill the entire
desktop.

7. Click the Minimize button on the title bar of the Word window. The Excel
window becomes the active window. The second Word window appears
behind the Excel window.

8. Click the Close button on the title bar of the second Word window. The
Excel window is still the active window. Notice that the Word program
button on the taskbar no longer has an arrow to indicate multiple
documents.

9. Make the Word window the active window by clicking the Word button on
the taskbar.

10. Click the Restore Window button on the Word window. The Word window
reduces in size. The Excel window might be partially visible behind the
Word window. You can drag the two reduced windows so that parts of both
can be seen simultaneously.

11. Drag the title bar of the Word window until you can see more of the Excel
window. Use both title bars to reposition the windows.

NOTE: Some program windows, such as those for Excel and Word,
contain two sets of sizing buttons. The upper set (on the title bar) controls the

program window. The lower set controls the sizing of the document within the program
window. See Figure 11 for the location of the lower set in Excel.

12. Click the Close buttons on the title bars of each of the two program
windows to close them. You have a clean desktop again.

Using the Documents Command
Windows lets you open a recently used document by using the Documents com-
mand on the Start menu. This command allows you to open one of up to 15 docu-
ments previously saved on your computer.

1. Click the Start button on the taskbar to display the Start menu.

2. Choose My Recent Documents. The My Recent Documents submenu appears,
showing you up to the last 15 documents that were saved.

3. Click a document. The program in which the document was created opens
and the document displays. For example, if the document you chose is a
Word document, Word opens and the document appears in a Word
program window.

4. Click the program window’s Close button. (Remember, to close the
program, you must click the Close button on the title bar. To close a
document, the lower set of buttons are clicked.) The program window
closes and the desktop is clear once again.
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Changing the Display to Classic View
The Display icon on the Control menu lets you change the way Windows looks
and works. Because your computer in school is used by other students, you should be very
careful when changing settings. Others might expect Windows to look and work the
standard way. Having Windows look or work in a nonstandard way could easily
confuse them. (Table 5 describes where to access other settings.)

To change the appearance of your computer to Classic view, follow these steps.
Talk to your instructor first, however, before changing any settings on your
computer.

1. Click the Start button on the taskbar.

2. Click Control Panel. The Control Panel submenu displays.

3. Click the Display icon. The Display dialog box is displayed.

4. Click the Appearance tag. The Appearance dialog box displays.

5. Drag the pointer to the Windows And Buttons box.

6. Click the arrow button on the right to choose the style of Windows you
prefer. Click Windows Classic View.

7. Click Cancel to close the Display submenu without making any changes.

Using the Search Command
If you don’t know where a file or folder is located, you can use the Search com-
mand on the Start menu to help you find and open it.

1. Click the Start button on the taskbar.

2. Click Search. The Search dialog box appears.

3. Click For Files Or Folders. The Search Results dialog box appears. The left
panel, titled “Search by any or all of the criteria below,” contains selection
boxes and additional menus for making a search. See Figure 12.

20 OFFICE

OPTION USE

Control Panel Displays the Control Panel window, which lets you change screen colors, add
or remove programs, change the date and time, and change other settings for
your hardware and software. The items listed below are accessed from the
Control Panel.

Network Connections Displays a submenu that lets you make connections with other computers or a
private network.

Printers and Faxes Displays the Printers window, which lets you add and remove printers, as well
as modify your printer settings.

Taskbar and Start
Menu

Displays the Taskbar and Start Menu Properties dialog box, which you use to
customize the taskbar and add and remove programs on the Start menu.

TABLE 5 Settings Options

P:\010Comp\PAS\447-5\Web01.vp
Friday, July 16, 2004 2:59:52 PM

Color profile: Generic CMYK printer profile
Composite  Default screen



PAS/CAS / OFFICE 2003 / Hinkle, Stewart, Juarez, Carter, Graves / TE 22466-1/SE 225447-5 / Appendix A

4. Type the name of the file or folder you want to find in the All Or Part Of
The File Name box.

To search files for specific text, use the Word Or Phrase In The File text box. To
search for files by date, size, type, or other attributes, click More Advanced Options
at the bottom of the left panel.

1. Click the down arrow next to the Look In text box to specify where you
want Windows to search. The default location is the C drive.

2. Click Search to start the search. Any matches for the file are shown in the
dialog box right panel.

3. Double-click any found item to open the program and view the file or
folder Windows has located.

4. When you are finished with your search, close all open windows and clear
your desktop.

Using the Run Command
Windows allows you to start a program by using the Run command and typing
the program name. This command is often employed to run a “setup” or “install”
program that installs a new program on your computer. It is best to use this com-
mand after you have become more familiar with Windows XP.

1. Click the Start button on the taskbar.

2. Choose Run. The Run dialog box appears. See Figure 13 on the next page.
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FIGURE 12
Search Results

dialog box
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3. If you know the name of a
program you want to run, type
the name in the Open text box.
Often you will need to click
Browse to open a drop-down list
of the disk drives, folders, and
files available to you.

4. Click Cancel to close the Run
dialog box.

Deleting Files Using the Recycle Bin
The recycle bin is the trash can icon on your desktop. To delete a file:

1. Click its icon and drag it to the recycle bin.

NOTE: As a protection against deleting a file unintentionally, any file you
have placed in the recycle bin can be undeleted and used again.

2. Double-click the Recycle bin icon. A window opens listing files you have
deleted.

3. To undelete a file, merely drag it out of the recycle bin window and place it
on the desktop.

4. To empty the Recycle Bin and permanently delete files, right-click the
Recycle Bin icon. Its menu appears.

5. Click Empty Recycle Bin.

Exiting Windows
You should always exit any open programs and Windows before turning off the
computer. This is the best way to be sure your work is saved. Windows also per-
forms other “housekeeping” routines that ensure everything is ready for you
when you next turn on your computer. Failure to shut down properly will often
force Windows to perform time-consuming system checks the next time it is
loaded. You can either log off the computer to make it available for another user,
or shut it down entirely.

To Log Off
1. Click the Start button on the taskbar.

2. Choose Log Off from the Start menu. The Log Off dialog box appears.

3. Click Log Off. Click Switch User to return to the logon screen for another user
to log on.
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FIGURE 13
Run dialog box
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To exit Windows, use the Turn Off Computer command on the Start menu. This
command has several shut-down options:

Restart Restarts the computer without shutting off the power. This is
sometimes necessary when you add new software.

Shut down Closes all open programs and makes it safe to turn off the
computer. Some computers will turn off the power automatically.

Stand By Puts the computer in a low activity state. It appears to be turned off
but will restart when moving the mouse.

Hibernate Places the computer in a mode that turns off the computer but
saves the state of your computer screen before you shut down.

1. Click the Start button on the taskbar.

2. Choose Shut Down from the Start menu. The Shut Down Windows dialog
box appears.

3. Click the Shut Down icon.

4. To access Hibernate, press the [Shift] key. The Stand By button toggles to the
Hibernate button.

5. Windows prompts you to save changes in any open documents. It then
prepares the computer to be shut down.

6. When Windows tells you it is safe to turn off your computer, turn off your
computer and your monitor.
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